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Sprint Media Manager FAQs 
What is Sprint Media Manager? 
 
Sprint Media Manager is a free, PC-based software application that allows you to:  

• Quickly and easily transfer music, pictures and video between your personal 
computer and your phone.  

• Build playlists, burn CD mixes and load music to your phone.  
• Manage your music, pictures and video — on your phone and PC. 

 
You’ll find Media Manager on the installation CD included with the Instinct or at 
sprint.com/downloads. 
 
 
What is the difference between transferring media to the phone using Windows 
Explorer versus Sprint Media Manager? 
 
Not all media types are supported by the phone. When you transfer media using 
Windows Explorer, the files are transferred “as is” regardless of whether or not the 
phone supports the media types. Sprint Media Manager recognizes unsupported media, 
which are transcoded to one of the recognized media types during the transfer process.  
 
 
How do I activate my Instinct on Sprint Media Manager? 
 
To activate your Instinct on Sprint Media Manager, perform the following steps:  

• Launch Sprint Media Manager.  
• Connect the Instinct to your PC.  
• When the activation screen appears, enter your email address, name the new 

phone in the appropriate fields and click Activate. You must enter this 
information in order to activate.  

• When Sprint Media Manager opens, the name of the connected phone appears 
in the top left part of the window above the phone capacity indicator. Note: You 
can only connect one activated phone at a time to Sprint Media Manager.  

 
 
Why can’t I activate my phone after installing Sprint Media Manager?  
 
If you can’t activate your phone after installing Sprint Media Manager, check the 
following:  

• Make sure the USB cable that came with your phone is securely connected to 
both the phone and to your computer's USB port.  

• In addition to connecting your phone to your PC, make sure you also entered a 
name for the phone and your email address in the appropriate fields in the 
Product Activation screen. You must enter this information in order to activate.  

• Verify that a Micro SD card is inserted in the appropriate place in the phone. 
Note: Do not remove the memory card from the phone. Removing the memory 
card may cause damage to the card. 
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Note: If you confirm these steps and you are still unable to activate your phone, 
disconnect the phone, reconnect it with the PC and try to activate again.  

 
 
After I installed Sprint Media Manager and activated my phone, can I use it with 
another Instinct?  
 
Yes, Sprint Media Manager application allows you to connect and activate multiple 
Instinct phones, although you can only connect and activate one phone at a time. 
 
 
How does Sprint Media Manager know which phone is connected after I activate 
multiple phones? 
 
Sprint Media Manager detects which phone is connected the minute you connect your 
phone to the PC. The correct name of the connected phone will appear in the top left 
part of the window above the phone capacity indicator. 
  
Note: You can only connect one activated phone at a time to Sprint Media Manager.  
 
 
Can I connect two Instinct phones to the PC using Sprint Media Manager?  
No, you can only connect one activated phone at a time to Sprint Media Manager.  
 
 
I have audio files on my PC that are not being imported to Sprint Media Manager 
with the "Add Media" wizard. 
 
If audio files on your PC are not being imported to Sprint Media Manager with the “Add 
Media” wizard, they may include non-standard audio files or standard audio files that are 
shorter than seven seconds in length.  

• Non-standard audio files (WAV) that cannot be transcoded or transferred to the 
phone cannot be added and will not appear in the Sprint Media Manager.  

• Standard audio files that are less than seven seconds cannot be added and will 
not appear in Sprint Media Manager. Only AMR files that are less than seven 
seconds will be added. 

 
Note: You can add standard audio files shorter than seven seconds to Sprint Media 
Manager by dragging them from MS Windows to the Music “Contents” center window. 
 
 
What do I do if video files on my PC are not being imported to Sprint Media 
Manager with the "Add Media" wizard? 
  
If video files on your PC are not being imported to Sprint Media Manager with the Add 
Media wizard, perform the following steps:  

• Make sure the Videos check box is selected in the Add Media - Step 1 of 2 
screen.  

• Open the Add Media Preferences window and make sure that all of the desired 
file types you want to import to the application are selected. 
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• Make sure you have Apple QuickTime software installed on your PC. File types 
that require QuickTime software will not be imported to Sprint Media Manager if 
QuickTime is not installed on the PC.  

 
 
How can I be sure my media library will be updated accordingly in Sprint Media 
Manager if I delete media from my PC? 
  
To ensure that your entire media library in Sprint Media Manager is updated after 
deleting media from your PC, use the Synchronize Library feature in the File menu. 
The Synchronize Library function will synchronize even those folders on your PC that 
are not being monitored by the Media Monitor. 
 
If the media that was deleted from a folder is monitored by the Media Monitor, the 
deleted media should be automatically removed from Sprint Media Manager. However, 
when the media monitor is turned off all media monitoring is stopped and media changes 
in the monitored media folders are not tracked. The media changes that occurred while 
the media monitor is not running cannot be tracked later when the monitor is turned on 
again.  
 
 
What file types are supported by the Sprint Media Manager? 
 
Import/Playback on PC 
Music Photos Videos 
AMR BMP 3G2 
M4A (unprotected AAC) GIF 3GP 
M4P (protected AAC) JPEG AVI 
MP3 PNG M4V 
WMA  MOV 
WAV  MP4 
  WMV 
 
Transfer to Phone 
Any DRM protected formats can not be transferred to the phone. 
Music or Videos may be transcoded to a format and/or size which the phone supports. 
 
 
Will deleting a file from Sprint Media Manager delete it permanently from my PC as 
well? 
  
No, the Sprint Media Manager delete function will only remove the file from the Media 
Manager library. The file will remain in its current location on your PC and can be added 
to the Media Manager again at any point.  
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How do I delete a file from Sprint Media Manager and from my PC at the same 
time? 
 
When you attempt to delete a file in the Media Manager, a message will appear asking 
you to confirm your wish to delete the selected file. This message contains a check box 
option to Delete from disk. Selecting this option will delete the selected file completely 
from the PC and from the Media Manager. You must select this option individually for 
each file that you wish to delete.  
 
 
What should I do if I select Digital Lounge in Music and Digital Lounge does not 
open? 
 
If you select Digital Lounge in Music and Digital Lounge does not open, perform the 
following steps:  

• Make sure that you are connected to the Internet. 
• Click Refresh on your web browser to refresh the page. 
• If you still can’t see the page, confirm that you are using Microsoft Internet 

Explorer 7 or a higher version. If you are using an outdated version, you will need 
to upgrade your web browser and try again.  

 
 
Why do I see script errors when viewing the Digital Lounge home page? 
 
Script errors are generated by Internet Explorer. If you see script errors when viewing 
the Digital Lounge home page, change your Internet Explorer settings to disable them by 
performing the following steps:  

• Open Internet Explorer and select Internet Options from the Tools menu.  
• Open the Advanced tab.  
• Check Disable script debugging (Other).  
• Next, select Apply to save your changes.  

 
 
What should I do when the download of a song stopped in the middle? 
 
If there is a power failure or some other problem while downloading from the Digital 
Lounge, you will have a partially downloaded song on your disk but this song will not 
appear in Purchased Music or in My PC in Sprint Media Manager. Follow the steps 
below in order to allow Digital Lounge to download the song again. 

• Run the Add Media wizard to add the song to the Sprint Media Manager. 
• Delete the song from the Sprint Media Manager and make sure you set the 

checkbox to Delete it from the disk as well. 
• If the song is not added to the Sprint Media Manager, look in your My Music 

folder on the PC. Check if the song exists under Artist\Album folder and delete it 
from there. 

• Click the Purchased Songs button in Digital Lounge to download the song. 
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When I try to play a WMA-protected song the application freezes, what should I 
do? 
 
Protected WMA songs need to have an updated license to play. This might happen 
when the song requires a security upgrade. Follow the steps below to update the 
license. 

• Open Windows Media Player, find the same song and double click on it. 
• A security upgrade is required to play this file message appears, click Yes to 

upgrade the song 
• The song should now play in Sprint Media Manager. 

 
Acronyms: 
WMA - Windows Media Audio is a digital audio file format created by Microsoft. 
 
 
What is the “To Phone” transfer list? 
 
The “To Phone” transfer list displays the list of media files that you create before the 
actual transfer. You can add or remove files at any time and they will transfer to your 
phone the next time you connect it to your personal computer and click the “Transfer 
Now” button.  
 
 
What is the difference between transferring media to the phone using the MY 
PHONE node in the navigation tree versus using the “To Phone” transfer list? 
  
When you transfer media using the MY PHONE node, the phone must be connected to 
your personal computer. However, you can create a list of media files in the To Phone 
transfer list at any time. These files will transfer the next time you connect the phone to 
your personal computer and click the Transfer Now button. 
 
 
What is the difference between transferring media from the phone using the MY 
PC node in the navigation tree versus using the “To PC” transfer list? 
 
The phone must be connected in both cases. However, the To PC transfer list displays 
the list of media files before the actual transfer and allows you to add or remove files. If 
you transfer by “dragging and dropping” from the MY PC node to the MY PHONE node, 
the file(s) will be automatically transferred.  
 
 
Why can’t I sort my music playlist? 
 
Only the MY PC playlist that contains your music library can be sorted by clicking the 
column headers. To rearrange regular music playlists, drag and drop the order you 
would like or use the Move up or Move down right-click menu options.   
NOTE:  For music, the view must also be in List view and not Album view. 
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How can I automatically transfer music to my phone based on available memory? 
  
To automatically transfer music to your phone based on available memory, perform the 
following steps:  

• Ensure your phone is connected to the PC with a USB cable.  
• Launch Sprint Media Manager.  
• Select Auto Fill Phone with songs to automatically fill your phone’s memory 

card with music. Note: The music is randomly selected by Sprint Media 
Manager.  

 
 
I inserted a CD into my PC. In the Audio CD view, I see the track numbers listed, 
but I don’t see the song titles. 
 
When a CD is inserted, a CD lookup is performed to return data from the AMG server 
containing the track information. This feature will only work if your PC is connected to the 
internet. Connect your PC to the internet and try again.  
 
Acronyms: 
AMG - All Media Guide is a music, movie and game metadata database company. 
 
 
I burned an Audio CD. In Audio CD view, I see incorrect track information. 
 
The CD lookup that is performed will only work correctly for CDs that were manufactured 
by Music vendors.  
 
 
What is “Update Metadata”? 
 
Update Metadata is a feature that works on individual song tracks. The track data is 
uploaded to the AMG server, which returns the metadata for the track. Sprint Media 
Manager takes this metadata (song title, artist, genre, etc.) and adds it to the song track. 
This feature is useful if you have tracks that were ripped without metadata or with 
incorrect metadata. This function can be invoked on single tracks by clicking Update in 
the song properties window. 
 
Note: The DRM sound file’s metadata is not updatable; therefore, the metadata can’t be 
updated and the option is not available. 
 
Acronyms: 
AMG - All Media Guide is a music, movie and game metadata database company. 
DRM – Digital rights management is used by content providers to prevent unauthorized 
duplication of digital media or devices. 
 
 

©2008 Sprint          - 7 - 



Can I remove songs that are duplicated on my PC and in my Sprint Media Manager 
music library? 
 
Yes, simply open the File menu and select Show Duplicate Songs. When the list of 
duplicate songs is displayed, you will have the option to remove duplicate songs from 
your Sprint Media Manager music library or delete them completely from your PC.  
 
 
Why can't I add a photo to a transfer list? 
 
If you are viewing the photo in Full View, the photo cannot be dragged and dropped into 
the transfer list. You must right click on the photo, select Transfer and then select the 
desired transfer list. In Thumbs or Details view, you also have the option to drag and 
drop the photo in a transfer list.  
 
 
How do I navigate within a photo slideshow or exit the photo slideshow? 
 
To navigate within a photo slideshow or exit the photo slideshow, click with your mouse 
while the slideshow is running to open the navigation bar at the bottom of the slideshow 
screen. Alternatively, right click while the slideshow is running to open a right click menu 
that allows you to navigate within the slideshow or exit the slideshow.  
 
 
How do I exit the video Full Screen view and return to Actual Size view? 
 
Press the Esc button on your keyboard to exit the video Full Screen view and return to 
Actual Size view.  
 
 
I changed my Sprint Media Manager window size while playing a video in Video fit 
to window mode and the video size changed, how do I get back to Video fit to 
window mode? 
 

• While playing the video, click on the Video actual size next to the video player 
controls. 

• Next, click Video fit to window to return to the Video fit in window mode.  
 
Note: Do not change Sprint Media Manager window size while playing the video.  
 
 
How do I make sure I have the latest version of Sprint Media Manager? 
 
To ensure you have the latest version of Sprint Media Manager, perform the following 
steps:  

• Launch Sprint Media Manager on your Internet-connected PC.  
• Navigate to the Help menu.  
• Select Check for updates.  
• Media Manager will automatically check for and install recent updates.  
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Is a Macintosh version of Sprint Media Manager available? 
 
No, a Macintosh version of Sprint Media Manager is not available at this time. 
 


